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CA Workload Automation iXp - 11.3.5

Release Notes

Welcome to CA Workload Automation iXp.

This section describes new features, fixed issues, supported platform information, system
requirements, and known issues, if any.
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11.3.5 Incremental 5

This section includes new features and issues fixed in CA Workload Automation iXp Release 11.3.5
INCRS:

@

Important! If you are using CA Workload Automation iXp v7.2 or lower versions, upgrade
CA Workload Automation iXp to 11.3.5 and then apply the following 11.3.5 INCR5 patches:

= CA Workload Automation iXp: RO91051
= CA Workload Automation iXp CA Third-Party Requirements: RO91053

For more information about applying these patches, see the readme files in the patches.

= New Features (see page 8)
= Support for CA Workload Automation AE Release 11.3.6 SP4 (see page 8)
= Update the Group and Application Attributes of a Job in Job Editor (see page 9)
= Support for New Job Types (see page 9)
= Find Job By Dialogs (see page 9)
= |nstance-Level Job Type Filter (see page 9)
= List All Future SendEvents (see page 9)
= Job Name Update in Job Editor (see page 9)
= Configurable Job Name Prefix Length (see page 10)
= Fixed Issues (see page 10)
= iXp Login Window Shows Outdated Copyright Year (see page 10)
= Job Column in Find Job By Dialogs is Not Expandable (see page 10)

New Features

Support for CA Workload Automation AE Release 11.3.6 SP4

CA Workload Automation iXp now supports CA Workload Automation AE Release 11.3.6 SP4.

01-Aug-2016 8/27
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Update the Group and Application Attributes of a Job in Job
Editor

Users can specify or update the name of a group and an application in the Basic page of the Job Editor
(https://docops.ca.com/display/IXP1135/Edit+Jobs) or the iXp JIL console, so that the job is associated to
the specified group and application.

Support for New Job Types

CA Workload Automation iXp now supports these job types: File Trigger and FTP

Find Job By Dialogs

The File Trigger and FTP options are added to the Job Type drop-down in the following dialogs under
View > Find Job By:

= Find Job By Type
= Find Job By Description
= Find Job By Owner

= Find Job By Machine

Instance-Level Job Type Filter

The following options are added to the Job Type section in the Instance tab (https://docops.ca.com
/display/IXP1135/Configure+CA+Workload+Automation+AE+Instance) of the iXp Admin tool:

= FT

= FTP

List All Future SendEvents

Users can now retrieve the list of all future sendevents using the Refresh future events button in the
Sendevent dialog. Only one event can be selected at a time from the list and unsent.

Job Name Update in Job Editor

In the previous release, when a user enters a job name that does not pass authorization validations,
the Job Editor dialog gets closed and the job must be inserted again from Definition -> Edit Jobs.

In this release, user can now change the job name in the Job Editor dialog.

01-Aug-2016 9/27
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Configurable Job Name Prefix Length

Fixed

Users can now override the default setting of "3" for job name prefix length.

iXp has built in functionality to export user view as JIL. It uses autorep command to load job
definitions. Due to the limitation in autorep, a set of jobs using only one job name definition can be
pulled. Calling autorep for each job separately is time consuming. Hence, iXp groups the jobs by
prefixes and then supplies these prefixes to autorep. For example, the output of the command
"autorep -J job_name_prefix%" may contain jobs that are not part of the view. These jobs are then
filtered by iXp.

The default value "3" may be insufficient for some businesses as it may cause thousands of jobs being
pulled from the CA Workload Automation AE server. Hence, you can override the default value by
configuring the following java VM variable:

ixp.job name prefix length

Example: - Di xp. j ob_nane_prefix_| engt h=6

[ssues

iIXp Login Window Shows QOutdated Copyright Year

The login window of the iXp GUI and iXp Admin tool shows an outdated copyright year.

This issue is fixed.

Job Column in Find Job By Dialogs is Not Expandable

The Job column in the Find Job By dialogs under View > Find Job By is not expandable. Hence, the
long job names are not displayed properly.

This issue is fixed.

01-Aug-2016
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11.3.5 Incremental 4

This page describes the new features delivered in CA Workload Automation iXp Release 11.3.5 INCR4:

= Job Detail View - New Information Fields (see page 11)
= Job Editor Window - New Fields: (see page 11)

= Calendar Editor Window - Dependent Jobs List (see page 11)
= Additional Job Type Information (see page 12)

= New Filter Editor Definitions (see page 12)

= Filter Editor - Calendar Tab (see page 12)

= Additional Filters (see page 12)

= Hostname Command (see page 12)

= Additional Job Detail Filters (see page 12)

= HTML Support for 'Message of the Day' (see page 12)
= Graph Columns Group and Application (see page 13)

= QuickFilters (see page 13)

= Server/Client Connection Information (see page 13)

= CLI - ixuserjobcmd (see page 13)

= CLI - ixautocal_asc (see page 13)

Job Detail View - New Information Fields

The Job detail view now has additional information fields:
= Group

= Application

Job Editor Window - New Fields:

The Job Editor Window now has additional information fields:
= Group

= Application

Calendar Editor Window - Dependent Jobs List

The calendar editor window shows a list of dependent jobs. Select a calendar from the drop down
menu to show jobs that are using this calendar including information on whether the calendar is used
as a run calendar or an exclude calendar.

01-Aug-2016 11/27
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Additional Job Type Information

Job logs, job error logs and spool files are now accessible for all Additional Job Type Information.

New Filter Editor Definitions

The ‘Group’ tab is renamed as ‘iXp Group’ tab to avoid confusion with WA AE Groups. You can filter
the definitions now in the Filter Editor.

Filter Editor - Calendar Tab

You can now create and filter jobs via the calendar:
= Show all jobs that are associated with a particular calendar schedule.

= Right click job to open context menu select to ‘show in console’.

Additional Filters

New ‘group’ support for filtering by CA Workload Automation AE groups and new ‘application’
support for filtering by applications in the filter editor.

Hostname Command

New command ‘IXP_USERCOMMAND_USER_HOSTNAME’ used to return your hostname.

Additional Job Detail Filters

Filter by ‘group’ or ‘application’ to display jobs matching the selected group or application.

HTML Support for ‘Messade of the Day'

Message of the Day now supports html markup for message customization.

01-Aug-2016 12/27
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Graph Columns Group and Application

Additional columns in the console for organizing progress graphs by Group and Application.

QuickFilters

You can create quick filters by clicking on one of these job attributes: Status, Run Machine, Group,
Application, Box name, in the job detail view. Filters are dynamically generated and are not saved. If
you want to save, create a copy in the Filter Editor with a new save name.

Server/Client Connection Information

Both iXp Gui and IXp AdminTool users can see the name of the iXp server they are connected to.
Information is visible in the top right corner next to the user name.

CLI - ixuserjobcmad

Provides the ability to run previously defined user job commands from the command line.

CLI - ixautocal_asc

ixautocal_asc is now able to relay command line arguments to underlying autocal_asc with iXp
security and audit. When using the Import or Export option, the specified files are transported to
/from the iXp server. This is now the preferable way of importing/updating calendars from CLI
because this bypasses WA AE 11.3 -> 11.3.5 behavior inconsistency (overwriting instead of updating
calendars when using input

redirect “<”).
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11.3.5 Incremental 3

This page describes the new features and fixed issues in CA Workload Automation iXp Release 11.3.5
INCR3:

= New Features (see page 14)

= Support for CA Workload Automation AE Release 11.3.6 (see page 14)
= Support for Log Filtration (see page 15)
= Fixed Issues (see page 15)

= 11.3.6 Version Option Not Listed on the Instance tab of iXp Admin Tool (see page 15)

= Calendar Editor Denies Calendar Access for Users with Read Privilege (see page 15)

= Calendar Editor Toolbar Icons Not Dynamically Displayed Based on the Calendar Type (see
page 15)

= Date Condition Check Box Not Selected in iXp Job Editor (see page 15)

= iXp JIL Command Failed to Execute (see page 16)

= iXp System Call Hung in UNIX_Linux Environments (see page 16)

= Job Detail View Displayed Incorrect Global Variable Value (see page 16)

= Job Flow View Not Displayed for a Three-Letter Site Name that Matches an Instance Name
(see page 16)

= Log File Retrieval Failed for CA Workload Automation AE Jobs (see page 16)

= Sendevent Dialog Not Refreshed After a Sendevent Invocation (see page 16)

= Sendevents JOB_ON_NOEXEC and JOB_OFF_NOEXEC Not Supported for CA Workload
Automation AE Release 11.3.6 Jobs (see page 17)

= Unknown Job Type Displayed for CA Workload Automation AE Release 11.3.5 or Release
11.3.6 Jobs (see page 17)

New Features

Support for CA Workload Automation AE Release 11.3.6

CA Workload Automation iXp now provides support for CA Workload Automation AE Release 11.3.6.

Note: The CA Workload Automation iXp Job Editor supports only Command, Box, and File
Watcher job types. The job types that are added to CA Workload Automation AE after
Unicenter AutoSys JM 4.5 are not supported. However, users can view or define the
additional job types using the ixautorep or ixjil CLI commands.

01-Aug-2016 14/27
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Support for Log Filtration

The iXp Admin Tool supports the log filtration option that lets users filter the iXp server logs based on
a search keyword. To filter the logs, specify a keyword in the Find in log field and click the Previous or
Next button.

Fixed Issues

11.3.6 Version Option Not Listed on the Instance tab of iXp
Admin Tool

When you defined a new CA Workload Automation AE 11.3.6 instance, 11.3.6 version option was not
listed in the Version drop-down on the Instance tab. This issue has been fixed. You can now select
11.3.6 from the Version drop-down list when you define a new CA Workload Automation AE 11.3.6
instance.

Calendar Editor Denies Calendar Access for Users with Read
Privilege

Users with calendar read privileges on an instance were denied access to calendars by the calendar
editor. This issue has been fixed. Users can now view all calendars for which read privileges are
assigned on an instance.

Calendar Editor Toolbar Icons Not Dynamically Displayed
Based on the Calendar Type

When an instance defined with an extended calendar was selected from the AUTOSERV drop-down
list, all icons were displayed in the calendar editor toolbar. This issue has been fixed. The calendar
editor toolbar icons are dynamically displayed based on the standard calendar, extended calendar, or
the cycle that an instance is defined with. For an extended calendar, the toolbar displays specific
icons and disables the remaining ones.

Date Condition Check Box Not Selected in iXp Job Editor

When you ran the ixpautorep command with the date condition attribute (t), the Date Condition
check box was not selected on the iXp Job Editor. iXp ignored the attribute. This issue has been fixed.
iXp Job Editor now selects or clears the Date Condition check box based on the date condition
attribute that you define in the ixpautorep command.
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iXp JIL Command Failed to Execute

If you specified an escaped double quote (\") at the end of a JIL command, the JIL command failed to
execute. You can now execute the JIL command that ends with an escaped or unescaped double
quote.

iIXp System Call Hung in UNIX_Linux Environments

Valid on UNIX and Linux
When iXp server sent a system call to CA Workload Automation AE, the system call hung. This issue
has been fixed. iXp now terminates the hung system call after 30 minutes.

Job Detail View Displayed Incorrect Global Variable Value

When you set a global variable on an instance using a job in another instance, iXp assumed that the
global variable is set on the instance where the job is defined. So, the job detail view displayed the
wrong instance name and an undefined value. This issue has been fixed. The job detail view now
displays the correct global variable value with appropriate instance name.

Job Flow View Not Displayed for a Three-Letter Site Name
that Matches an Instance Name

If you specified a three-letter site name that matches an instance name, the job flow view for the site
name was not displayed. The minimum number of characters for a site name is now four.

Log File Retrieval Failed for CA Workload Automation AE
Jobs

When you retrieved the log file for a CA Workload Automation AE Release 11.3.5 or higher job, the
log file could not be viewed. For example, if you retrieve the standard error log file for the job (TEST)
of the instance (ORG), the following message appears:

ORG-TEST: "STD_ERR_FILL": invalid identifier

This issue has been fixed. You can now retrieve log files for all CA Workload Automation AE jobs.

Sendevent Dialog Not Refreshed After a Sendevent
Invocation

When you opened the Sendevent dialog from the File menu in iXp user interface, the Sendevent
dialog displayed the job from the previous Sendevent invocation. This issue has been fixed. The
Sendevent dialog now displays the selected job. Open the Sendevent dialog after you select a job in
the tree view.
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Sendevents JOB_ON_NOEXEC and JOB_OFF_NOEXEC Not
Supported for CA Workload Automation AE Release 11.3.6
Jobs

The JOB_ON_NOEXEC and JOB_OFF_NOEXEC sendevents were not supported for CA Workload
Automation AE Release 11.3.6 jobs. This issue has been fixed. You can now issue the
JOB_ON_NOEXEC and JOB_OFF_NOEXEC sendevents for both CA Workload Automation AE Release
11.3.5 and Release 11.3.6 jobs.

Unknown Job Type Displayed for CA Workload Automation
AE Release 11.3.5 or Release 11.3.6 Jobs

When a CA Workload Automation AE Release 11.3.5 or Release 11.3.6 job was viewed in the Job
Editor dialog, the job type was displayed as UNKNOWN. This issue has been fixed. The job type is now
displayed correctly based on the type you specify in the CA Workload Automation AE job definition.
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Basic System Requirements

This section lists the system requirements for installing and running the iXp components. Some of the
prerequisite software is already present on the machines when the operating system is loaded.

Contents:

= Xp Daemon (see page 18)

= iXp Client (see page 18)
= iXp CLI (see page 19)

= iXp Agent (see page 19)

iIXp Daemon

= Apache Tomcat v6, v7, or v8 (64-bit implementation)

= PERL v5.8 or higher is recommended

= 2 GHz processor with two free cores

= 4 GB of available RAM

5 GB of disk space for full installation

JRE v1.6u45 and higher, v1.7u80 and higher, or v1.8u45 and higher (64-bit implementation)

= CA Workload Automation AE Full Client and configuration files for all instances of CA Workload
Automation AE that will be accessed.

The following table lists additional requirements for the iXp Server that depend on the type of

deployment;

Up to 50000 jobs,
10 concurrent users

Up to 100,000 jobs,
50 concurrent users

Up to 200,000 jobs,
100 concurrent users

Processor 2 GHz with two free 2 GHz with four free 2 GHz with four free
cores cores cores

Available RAM 4GB 8GB 16 GB

Disk space for full 5GB 10GB 10 GB

installation

iIXp Client

= JRE v1.6u45 and higher, v1.7u80 and higher, or v1.8u45 and higher (32- or 64-bit implementation)

01-Aug-2016

18/27



CA Workload Automation iXp - 11.3.5

= 2 GHz processor

= 1 GB of available RAM
Additional requirements that depend on the type of deployment are the following.

= Up to 50,000 jobs: 500 MB free physical memory
= Up to 100,000 jobs: 750 MB free physical memory
= Up to 200,000 jobs: 1 GB free physical memory

= The iXp user interface is designed to support a minimum screen resolution of 1280 x 720, but
higher resolutions are suggested for optimal experience.

iXp CLI

= JRE v1.6u45 and higher, v1.7u80 and higher, or v1.8u45 and higher (32- or 64-bit implementation)

= 5 MB of disk space

IXp Adent

= JRE v1.6u45 and higher, v1.7u80 and higher, or v1.8u45 and higher (Optionally, PERL v5.1 or
higher for the deprecated agent program)

= The CA Workload Automation AE sendevent, zgl, xgl binaries are optional. They are needed if you
want the iXp Daemon to automatically install and start the PERL-based iXp Agent.
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Operating System Support

Contents:
= CA Workload Automation iXp Server (see page 20)
= CA Workload Automation iXp Client (see page 21)
= CA Workload Automation iXp CLI (see page 21)

CA Workload Automation iXp Server

The CA Workload Automation iXp server component supports the following operating system
versions:

= Solaris
= Version 10, SPARC 64-bit
= Version 11, SPARC 64-bit
= Red Hat Enterprise Linux
= Version 5, x86 64-bit
= Version 6, x86 64-bit
= SuSE Linux Enterprise Server
= Version 10, x86 64-bit
= Version 11, x86 64-bit
= Windows Server
= Version 2008, x86 64-bit
= Version 2008 R2, x86 64-bit
= Version 2012, x86 64-bit
= HP-UX Version 11i v3, PA-RISC 64-bit
= AIX
= Version 6.1, POWER 64-bit

= Version 7.1, POWER 64-bit
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CA Workload Automation iXp Client

The CA Workload Automation iXp client supports the following operating system versions:
= Windows
= Version XP SP2, x86 32/64-bit
= Version Vista, x86 32/64-bit
= Version 7, x86 32/64-bit
= Version 2008, x86 32/64-bit
= Version 2008 R2, x86 32/64-bit
= Version 2012, x86 32/64-bit
= Red Hat Enterprise Linux
= Version 5, x86 32/64-bit
= Version 6, x86 32/64-bit
= SuSE Linux Enterprise Server
= Version 10, x86 32/64-bit

= Version 11, x86 32/64-bit

CA Workload Automation iXp CLI

The CLI is supported on the same operating systems as the CA Workload Automation iXp server,
including their 32-bit versions. Additionally, the CLI is supported on the following operating system
versions:
= HP-UX Version 11i v3, |IA 64-bit
= Windows
= Version 2003, X86 32/64-bit, only SP2 and higher
= Version 2003 R2, X86 32/64-bit, only SP2 and higher
= Version 2012, X86 32/64-bit

= Red Hat Enterprise Linux

= Version 5, zSeries 31/64-bit
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= Version 6, zSeries 31/64-bit
= SuSE Linux Enterprise Server
= Version 10, zSeries 31/64-bit

= Version 11, zSeries 31/64-bit
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CA Workload Automation AE Server Support

The CA Workload Automation iXp server and client components support CA Workload Automation AE
Releases 11.1 through 11.3.6 SP4 .
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Acknowledgements

This appendix contains copyright and license agreement information from third-party software used
in CA Workload Automation iXp.

Java SE Development Kit 6u34 Demos and
Samples 6u34

This product includes files from Java SE Development Kit 6u34 Demos and Samples v.6u34 which are
distributed in accordance with the following license agreement:

Oracle BSD License:

Copyright (c) 2012 Oracle and/or its affiliates. All rights reserved. Redistribution and use in source
and binaryforms, with or without modification, are permitted provided that the following conditions
are met:

= Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer. - Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution. - Neither the name of Oracle nor the names of its
contributors may be used to endorse or promote products derived from this software without
specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

jTDS v.1.2

This product is distributed with JTDS v.1.2 (the LGPL Software), the use of which is governed by the
following terms:

The LGPL Software is open source software that is used with this CA software program (the CA
Product). The LGPL Software is not owned by CA, Inc. (CA). Use, copying, distribution and
modification of the LGPL Software are governed by the GNU Lesser General Public License (LGPL)
version 2.1. A copy of the LGPL license can be found in the same directory on the installation disk on
which the LGPL Software is distributed. Additionally, a copy of the LGPL license can be found at
http://www.opensource.org/licenses/lgpl-2.1.phpor write to the Free Software Foundation, Inc., 59
Temple Place, Suite 330, Boston, MA 02111-1307 USA. CA makes the source code for the LGPL
Software available at http://opensrcd.ca.com (http://opensrcd.ca.com/), and includes a copy of
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thesource code on the same disk as the executable code.Use of the CA Product is governed solely by
the CA enduser license agreement (EULA), not by the LGPL license. You cannot use, copy, modify or
redistribute any CAProduct code except as may be expressly set forth in theEULA. The LGPL Software
is provided AS IS WITHOUTWARRANTY OR CONDITION OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Further details of the disclaimer of warranty with respect to the LGPL
Software can be found in the LGPL license itself. To the full extent permitted under applicable law, CA
disclaims all warranties and liability arising from or related to any use of the LGPL Software.

1.2.13

This product includes Apache Log4J 1.2.13 which is distributed in accordance with the following
license agreement:
Apache License Version 2.0, January 2004 http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

Definitions. "License" shall mean the terms and conditions for use, reproduction, and distribution as
defined by Sections 1 through 9 of this document. "Licensor" shall mean the copyright owner or
entity authorized by the copyright owner that is granting the License. "Legal Entity" shall mean the
union of the acting entity and all entities that control, are controlled by, or are under common

control with that entity. For the purposes of this definition, "control" means ﬂ the power, direct or
indirect, to cause the direction or management of such entity, whether by contract or otherwise, or
(ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of
such entity. "You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted
by this License. "Source" form shall mean the preferred form for making modifications, including but
not limited to software source code, documentation source, and configuration files. "Object" form
shall mean any form resulting from mechanical transformation or translation of a Source form,
including but not limited to compiled object code, generated documentation, and conversions to
other media types. "Work" shall mean the work of authorship, whether in Source or Object form,
made available under the License, as indicated by a copyright notice that is included in or attached to
the work (an example is provided in the Appendix below). "Derivative Works" shall mean any work,
whether in Source or Object form, that is based on (or derived from) the Work and for which the
editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an
original work of authorship. For the purposes of this License, Derivative Works shall not include works
that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and
Derivative Works thereof. "Contribution" shall mean any work of authorship, including the original
version of the Work and any modifications or additions to that Work or Derivative Works thereof,
that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an
individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of
this definition, "submitted" means any form of electronic, verbal, or written communication sent to
the Licensor or its representatives, including but not limited to communication on electronic mailing
lists, source code control systems, and issue tracking systems that are managed by, or on behalf of,
the Licensor for the purpose of discussing and improving the Work, but excluding communication
that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution." "Contributor" shall mean Licensor and any individual or Legal Entity on behalf of
whom a Contribution has been received by Licensor and subsequently incorporated within the Work.
Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
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grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
the Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall
terminate as of the date such litigation is filed.

Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet
the following conditions:

You must give any other recipients of the Workor Derivative Works a copy of this License; and

You must cause any modified files to carryprominent notices stating that You changed thefiles; and
You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent,
trademark, and attribution notices from the Source form of the Work, excluding those notices that do
not pertain to any part of theDerivative Works; and

If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works thatYou
distribute must include a readable copy of the attribution notices contained within such NOTICE file,
excluding those notices that do not pertain toany part of the Derivative Works, in at least oneof the
following places: within a NOTICE text filedistributed as part of the Derivative Works; withinthe
Source form or documentation, if provided alongwith the Derivative Works; or, within a
displaygenerated by the Derivative Works, if and whereversuch third-party notices normally appear.
The contents of the NOTICE file are for informational purposes only and do not modify the License.
You may add Your own attribution notices within Derivative Works that You distribute, alongside or
as an addendum to the NOTICE text from the Work, provided that such additional attribution notices
cannot be construed as modifying the License. You may add Your own copyright statement to Your
modifications and may provide additional or different license terms and conditions for use,
reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole,
provided Your use, reproduction, and distribution of the Work otherwise complies with the
conditions stated in this License.

Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation,
any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A
PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or
redistributing the Work and assume any risks associated with Your exercise of permissions under this
License.

Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.
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Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works
thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this License. However, in accepting such
obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of
any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor
harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your
accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

Oracle JDBC Driver 11.2.0.3

The following additional terms and conditions apply to your use of the Oracle software product
("Oracle Product"):

(1) you may only use the Oracle Product to run the CA Product; (2) to the extent permitted by
applicable law, Oracle disclaims liability for any damages, whether direct, indirect, incidental, or
consequential, arising from your use of the Oracle Product; (3) at the termination of this Agreement,
you must discontinue use and destroy or return to CA all copies of the Product; (4) Oracle is not
obligated to provide technical support, phone support, or updates to the Oracle Product hereunder;
(5) CA reserves the right to audit your use of the Oracle Product and report such use to Oracle or to
assign this right to audit your use of the Oracle Product to Oracle; (6) Oracle shall be a third party
beneficiary of this Agreement.

Note: This product is distributed with Oracle 11G JDBC Driver release 2 from Oracle USA,
Inc. ('Oracle').
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